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Uvod u Microsoft PowerPoint

Naslov: Šta je Microsoft PoverPoint?
Sadržaj:
• Definicija: PoverPoint je prezentacijska softverska aplikacija koju je razvio Microsoft, 

deo MS Office paketa
• Primarna svrha: Kreirajte profesionalne, zanimljive prezentacije koristeći slajdove koji 

kombinuju tekst, slike, grafikone i multimediju
• Ključne aplikacije:

• Akademske prezentacije i izveštaji sa projekata
• Tehnička dokumentacija i inženjerski predlozi
• Materijali za obuku i nastavni sadržaji
• Poslovne prezentacije i demonstracije proizvoda



Uvod u Microsoft PowerPoint

• Zašto PoverPoint za inženjere?
• Vizuelno komunicirajte tehničke koncepte
• Predstaviti rezultate projekta i analizu podataka
• Kreirajte dijagrame kola i prezentacije arhitekture sistema
• Dokumentovanje laboratorijskih eksperimenata i nalaza

Praktični primer:
• Inženjerske aplikacije: Pregledi dizajna, predlozi projekata, prezentacije odbrane teza



Pregled PoverPoint interfejsa

Naslov: Razumevanje PoverPoint Workspace-a
Sadržaj:
• Ribbon Interface: Organizovane kartice koje sadrže srodne komande

• Početna, Ubaciti, Dizajn, Prelazi, Animacije, Slide Shov, pregled, Pogled
• Glavne komponente:

• Naslovna traka: Prikazuje ime datoteke i ime programa
• Traka sa alatkama za brzi pristup: Često korišćene komande (Sačuvaj, Poništi, 

Ponovi)
• Okno slajdova: Prikaz sličica svih slajdova (leva strana)
• Područje za uređivanje slajdova: Glavni radni prostor za kreiranje sadržaja
• Okno za beleške: Dodajte beleške zvučnika ispod slajda
• Statusna traka: Prikazuje broj slajda, temu, opcije prikaza



Pregled PoverPoint interfejsa

• Pogledaj opcije:
• Normalni prikaz: Podrazumevani prikaz za uređivanje
• Slide Sorter Viev: Organizujte i promenite redosled slajdova
• Prikaz čitanja: Pregled prezentacije
• Prikaz slajdova: Režim prezentacije preko celog ekrana

Vežba:
• Otvorite PoverPoint i identifikujte svaki element interfejsa
• Prebacivanje između različitih pogleda i posmatranje promena



Kreiranje i čuvanje prezentacija

Naslov: Početak prezentacije
Sadržaj:
• Kreiranje nove prezentacije:

• Kliknite na Fajl → novi
• Izaberite neku izmenu: Prazna prezentacija, šabloni tema ili online šabloni
• Prazna prezentacija: Počnite od nule sa prilagođavanjem
• Šabloni: Unapred dizajnirane teme za dosledan izgled

• Čuvanje vašeg rada:
• Prvi put Sačuvaj: Fajl → Sačuvaj kao
• Izaberite lokaciju: Računar, OneDrive ili određenu fasciklu
• Unesite smisleno ime datoteke (npr. "EE_Project_Presentation_2025")
• Izaberite format datoteke: .pptx (podrazumevano), .pdf, .ppt (starije verzije)



Kreiranje i čuvanje prezentacija

• Funkcija automatskog čuvanja:
• Omogući AutoRecover: File → Opcije → Sačuvaj
• Podesite interval automatskog čuvanja (preporučeno: KSNUMKS-KSNUMKS minuta)

• Formati datoteka:
• .pptx: Standardni PoverPoint format (2007 i kasnije)
• .pdf: Univerzalni format gledanja koji se ne može uređivati
• .ppsk: PoverPoint Shov (otvara se direktno u režimu prezentacije)

Vežba:
• Kreirajte novu praznu prezentaciju
• Sačuvajte ga kao "My_First_PPT.pptx" u fascikli Dokumenti
• Omogućite automatsko čuvanje sa intervalima od 5 minuta



Rad sa slajdovima - dodavanje i upravljanje

Naslov: Osnove upravljanja slajdovima
Sadržaj:
• Dodavanje novih slajdova:

• Metod KSNUMKS: Početna kartica → Novo dugme slajdova (padajući meni za 
rasporede)

• Metod KSNUMKS: Kliknite desnim tasterom miša u oknu slajdova → novi slajd
• Metod 3: Prečica na tastaturi: Ctrl + M

• Izbor rasporeda slajdova:
• Naslov slajd: Prvi slajd sa naslovom i podnaslovom
• Naslov i sadržaj: Najčešći raspored
• Dva sadržaja: Uporedite dva elementa rame uz rame
• Poređenje: Dve kolone sa zaglavljima
• Prazno: Potpuna sloboda prilagođavanja



Rad sa slajdovima - dodavanje i upravljanje

• Brisanje slajdova:
• Izaberite slajd u oknu slajdova → pritisnite Delete ključ
• Kliknite desnim tasterom miša slajd → Obriši slajd

• Dupliranje slajdova:
• Kliknite desnim tasterom miša slajd → duplikat slajda
• Korisno za održavanje konzistentnog formatiranja

• Promena redosleda slajdova:
• Prevucite i ispustite u oknu slajdova
• Koristite Slide Sorter Viev za lakše upravljanje

Vežba:
• Dodajte 5 slajdova sa različitim rasporedima
• Duplikat slajda 3
• Promenite redosled slajdova povlačenjem u oknu slajdova
• Izbrišite jedan nepotreban slajd



Rad sa tekstom i tekstualnim kutijama
Naslov: Dodavanje i upravljanje tekstualnim sadržajem
Sadržaj:
• Korišćenje tekstualnih polja za placeholdere:

• Kliknite na područja "Kliknite da biste dodali naslov" ili "Kliknite da biste dodali tekst"
• Automatski formatiran na osnovu rasporeda slajdova
• Održavajte konzistentan razmak i poravnanje

• Kreiranje prilagođenih tekstualnih kutija:
• Ubaci jezičak → tekstualno polje
• Kliknite i prevucite da biste kreirali tekstualno polje željene veličine
• Pozicionirajte bilo gde na slajdu
• Korisno za napomene i etikete

• Svojstva tekstualnog polja:
• Promenite veličinu: Prevucite ugaone ručke
• Premesti: Kliknite na granicu i prevucite
• Rotate: Koristite ručicu rotacije na vrhu
• Delete: Izaberite granicu → pritisnite Delete



Rad sa tekstom i tekstualnim kutijama

• Tačke i liste:
• Povećajte indentaciju: Tab taster ili Povećaj nivo liste dugme
• Smanjite indentaciju: Shift + Tab ili Smanji nivo liste dugme
• Promenite stil metka: Početna → Bullets padajući meni
• Numerisane liste: Home → dugme za numerisanje

• Najbolje prakse:
• Koristite koncizne tačke (6-8 reči po tački)
• Ograničite na 6-7 metaka po slajdu
• Izbegavajte pune rečenice; Koristite ključne fraze

Vežba:
• Kreirajte slajd sa naslovom i KSNUMKS tačkama o vašoj inženjerskoj specijalizaciji
• Dodajte prilagođeno tekstualno polje sa napomenom
• Kreirajte numerisanu listu od 5 koraka za tehnički proces



Formatiranje teksta i tipografija

Naslov: Izrada teksta jasnim i profesionalnim
Sadržaj:
• Osnovno oblikovanje teksta:

• Tip fonta: Izaberite font iz padajućeg menija (preporučeno: Arial, Calibri, Tahoma)
• Veličina slova: 28-32pt za naslove, 18-24pt za tekst tela
• Podebljano, kurzivno, podvlačno: Koristite štedljivo za naglašavanje
• Boja fonta: Obezbedite visok kontrast sa pozadinom

• Poravnanje teksta:
• Levo: Standard za tačke
• Centar: Dobro za naslove
• Desno: Retko se koristi
• Justify: Distribuira tekst ravnomerno



Formatiranje teksta i tipografija

• Razmak između linija i pasusa:
• Početna → Razmak između linija
• Preporučena: 1.5 ili 2.0 za bolju čitljivost
• Podesite razmak pre / posle paragrafa

• Tekstualni efekti:
• Senka: Dodaje dubinu (koristite suptilno)
• Refleksija: Stvara efekat ogledala
• Sjaj: Naglašava tekst sa obojenom granicom
• Tekstualni pregled: Definiše granice teksta

• Razmak između znakova:
• Početna → Razmak između znakova
• Prošireno: Povećava razmak između slova (korisno za naslove)



Formatiranje teksta i tipografija

• Tipografski saveti za tehničke prezentacije:
• Koristite sans-serifne fontove (Arial, Calibri) za prezentacije ekrana
• Održavajte konzistentnost tokom prezentacije
• Izbegavajte preterane varijacije formatiranja
• Uverite se da je tekst čitljiv sa udaljenosti KSNUMKS + metara

Vežba:
• Formatirajte naslov slajda sa KSNUMKSpt bold fontom i suptilnom senkom
• Formatirajte tekst tela sa veličinom KSNUMKSpt i razmakom između linija KSNUMKS
• Eksperimentišite sa različitim bojama fonta (obezbedite kontrast)
• Primenite tekstualne efekte da naglasite ključni tehnički termin



Rad sa temama i rasporedima
Naslov: Kreiranje konzistentnih profesionalnih dizajna
Sadržaj:
• Razumevanje tema:

• Unapred dizajnirani setovi boja, fontova i efekata
• Obezbeđuje vizuelnu konzistentnost na svim slajdovima
• Profesionalni izgled uz minimalan napor

• Primena tema:
• Dizajn kartica → Teme galerija
• Zadržite pokazivač da biste pregledali temu na slajdovima
• Kliknite da biste se prijavili na celu prezentaciju
• Kliknite desnim tasterom miša na temu → Primeni na izabrane slajdove

• Tema Komponente:
• Šema boja: Koordinirana paleta boja
• Font set: Kombinacija fonta naslova i tela
• Stilovi pozadine: Čvrsta, gradijent ili tekstura
• Stilovi efekata: Vizuelni efekti za oblike i objekte



Rad sa temama i rasporedima

• Prilagođavanje tema:
• Dizajn → boje → prilagođavanje boja
• Dizajn → fontova → prilagođavanje fontova
• Dizajn → stilovi pozadine → pozadina formata

• Varijante:
• Različite šeme boja iste teme
• Odeljak Dizajn → varijante
• Brz način za promenu ukupnog izgleda

• Rasporedi slajdova:
• Početna → padajući meni raspored
• Promenite raspored bez gubitka sadržaja
• Svaka tema uključuje više rasporeda



Rad sa temama i rasporedima

• Preporuke za inženjerske prezentacije:
• Izaberite profesionalne, čiste teme (Office, Facet, Ion)
• Izbegavajte preterano dekorativne teme
• Koristite šeme boja visokog kontrasta za tehničke dijagrame
• Održavajte konzistentnost tokom prezentacije

Vežba:
• Primijenite 3 različite teme na svoju prezentaciju i uporedite
• Izaberite profesionalnu temu pogodnu za inženjering
• Prilagodite šemu boja tako da odgovara bojama vaše institucije
• Primijenite različite rasporede na različite slajdove



Ubacivanje i rad sa slikama

Naslov: Dodavanje vizuelnih elemenata u prezentacije
Sadržaj:
• Metode za umetanje slika:

• Ubaci karticu → Slike → ovom uređaju (sa računara)
• Ubaci karticu → Slike → Online slike (sa Interneta)
• Insert tab → Pictures → Stock Images (Microsoft biblioteka)
• Prevucite i ispustite iz File Ekplorer
• Kopiraj-nalepi iz drugih aplikacija

• Tipovi slika:
• Fotografije: JPG, PNG formati
• Grafika i logotipi: PNG (podržava transparentnost)
• Dijagrami kola: Uvoz iz softvera za crtanje
• Slike sa ekrana: Vindovs Snipping Tool ili Snip & Sketch



Ubacivanje i rad sa slikama

• Pozicioniranje slika:
• Kliknite i prevucite da biste se pomerili
• Alati za poravnanje: Format slike → Poravnanje
• Pošalji nazad / napred: Format slike → Arrange
• Mreža i vodiči: Pogledaj → Gridlines (za precizno postavljanje)

• Promena veličine slika:
• Prevucite ugaone ručke (održava odnos)
• Izbegavajte povlačenje bočne ručke (izaziva izobličenje)
• Format slike → veličina grupe (precizne dimenzije)
• Zaključavanje odnos za proporcionalno skaliranje

• Kvalitet slike:
• Koristite slike visoke rezolucije (minimalno 1024×768)
• Izbegavajte preterano uvećanje (izaziva pikselizaciju)
• Kompresija slika: Format slike → kompresija slika



Ubacivanje i rad sa slikama

• Razmatranja o autorskim pravima:
• Koristite besplatne slike ili stock slike
• Kreirajte sopstvene dijagrame i snimke ekrana
• Navedite atribuciju ako je potrebno

Vežba:
• Ubacite sliku dijagrama sa računara
• Ubacite sliku koja se odnosi na elektrotehniku
• Napravite snimak ekrana i ubacite ga u slajd
• Profesionalno promenite veličinu i pozicionirajte slike
• Kompresija slike da se smanji veličinu datoteke



Formatiranje i uređivanje slika
Naslov: Poboljšanje slika za bolje prezentacije
Sadržaj:
• Osnovna podešavanja slike:

• Format slike → korekcije
 Osvetljenost: Učinite sliku svetlijom ili tamnijom
 Kontrast: Podesite razliku između svetlih i tamnih područja
 Oštrina: Poboljšajte ili omekšajte detalje slike

• Format slike → boja
 Zasićenje: Podesite intenzitet boje
 Ton: Podesite temperaturu boje (toplo / hladno)
 Recolor: Primenite filtere u boji ili napravite sive tonove

• Obrezivanje slika:
• Format slike → Crop
• Prevucite crne ručke da biste uklonili neželjene oblasti
• Crop to Shape: Kreirajte kružne ili prilagođene slike
• Odnos aspekta: Obrezivanje na određene dimenzije (16: 9, 4: 3)



Formatiranje i uređivanje slika
• Granice i efekti slike:

• Picture Format → Picture Border
 Dodajte obojene granice slikama
 Podesite širinu i stil granice

• Format slike → efekti slike
 Senka: Dodaje dubinu iza slike
 Refleksija: Stvara efekat ogledala ispod
 Sjaj: Obojena granica oko slike
 Meke ivice: Perje ivice slike
 KSNUMKS-D efekti: Dodaje dimenziju

• Uklanjanje pozadine:
• Format slike → Ukloni pozadinu
• PoverPoint automatski detektuje predmet
• Označite područja koja treba zadržati (zelena) ili ukloniti (crvena)
• Korisno za slike proizvoda i tehničke komponente



Formatiranje i uređivanje slika
• Umetnički efekti:

• Nanesite filtere: skica olovkom, četka, akvarel
• Koristite štedljivo u tehničkim prezentacijama

• Aranžman slike:
• Sloj više slika: Bring Forvard / Pošalji unazad
• Grupni objekti: Izaberite više → Grupa
• Poravnajte i distribuirajte: Poravnajte levo, centar, desno, itd.

Vežba:
• Ubacite sliku i podesite osvetljenost i kontrast
• Izrežite sliku da biste se fokusirali na određenu komponentu
• Dodajte suptilan efekat senke na sliku
• Uklonite pozadinu sa slike komponente
• Grupišite više slika zajedno i poravnajte ih



Osnovne animacije

Naslov: Dodavanje pokreta elementima slajdova
Sadržaj:
• Šta su animacije?

• Vizuelni efekti koji se primenjuju na objekte na slajdu
• Kontrolišite kako se elementi pojavljuju, pomeraju ili nestaju
• Skrenite pažnju na ključne tačke tokom prezentacije
• Treba poboljšati, a ne odvratiti pažnju od sadržaja

• Vrste animacija:
• Ulaz: Kako se pojavljuju objekti (Fade, Fli In, Zoom)
• Naglasak: Skrenite pažnju na postojeće objekte (Pulse, Grov/Shrink)
• Izlaz: Kako objekti nestaju (Fade Out, Fli Out)
• Putanje kretanja: Premestite objekte duž definisanih putanja



Osnovne animacije
• Primena animacija:

• Izaberite objekat (tekstualno polje, slika, oblik)
• Kartica Animacije → Galerija animacija
• Kliknite na željeni efekat animacije
• Pregled: Gledajte animaciju automatski

• Okno animacije:
• Kartica Animacije → Okno animacije
• Prikazuje sve animacije na trenutnom slajdu
• Promenite redosled animacije: Prevucite gore ili dole
• Izbriši animacije: Izaberite i pritisnite Delete

• Animacija Tajming:
• Start opcije:

• Na klik: Animacija počinje kada kliknete
• Sa Prethodna: Počinje istovremeno sa prethodnom animacijom
• Posle prethodnog: Počinje nakon završetka prethodne animacije

• Trajanje: Brzina animacije (0.5-2 sekundi tipično)
• Kašnjenje: Sačekajte vreme pre nego što animacija počne



Osnovne animacije

• Najbolje prakse za inženjerske prezentacije:
• Koristite jednostavne, profesionalne animacije (Fade, Vipe)
• Izbegavajte poskakivanje ili upadljive efekte (Bounce, Spin)
• Animirajte tačke jedan po jedan radi jasnoće
• Ograničite na 2-3 animacije po slajdu
• Testirajte animacije pre predstavljanja

Vežba:
• Kreirajte slajd sa 4 tačke
• Nanesite "Fade In" ulaznu animaciju na svaku tačku
• Podesite tajming: "Posle prethodnog" sa trajanjem od 0,5 sekundi
• Dodajte naglasak "Pulse" važnom tehničkom terminu
• Pregledajte animacije i prilagodite vreme po potrebi



Slajd Prelazi
Naslov: Kreiranje glatkih promena slajdova
Sadržaj:
• Šta su tranzicije?

• Vizuelni efekti prilikom prelaska sa jednog slajda na drugi
• Primenjuje se na čitave slajdove (ne pojedinačne objekte)
• Kreirajte profesionalni protok između tema
• Razlikuje se od animacija (koje utiču na objekte)

• Vrste prelaza:
• Suptilno: Profesionalno i minimalno (Fade, Push, Vipe)
• Uzbudljivo: Dramatičnije (Kocka, Flip, Galerija)
• Dinamički sadržaj: Specijalni efekti (transporter, rotiranje)

• Primena prelaza:
• Izaberite slajd (e) u oknu slajdova
• Kartica Prelazi → Galerija tranzicije
• Kliknite na željenu tranziciju
• Primeni na sve: Koristite istu tranziciju tokom cele



Slajd Prelazi
• Opcije tranzicije:

• Opcije efekta: Varijacije pravca i stila
• Trajanje: Brzina tranzicije (0.5-2 sekundi)
• Zvuk: Dodajte zvuk prelazima (koristite retko)
• Unapred slajd:

• Na klik mišem: Ručna kontrola (preporučeno)
• Posle: Automatsko vreme (navedite sekunde)

• Pregled prelaza:
• Kliknite na dugme Pregled da biste videli efekat
• Slide Shov → From Current Slide (test full experience)

• Saveti za tranziciju:
• Koristite konzistentne prelaze tokom prezentacije
• Suptilni prelazi su profesionalni (Fade, Push)
• Izbegavajte zvučne efekte u profesionalnim okruženjima
• Ručno unapred vam daje kontrolu tokom prezentacije
• Vremenski prelazi pažljivo (1-1,5 sekundi je idealno)



Slajd Prelazi

• Preporučuje se za tehničke prezentacije:
• Fade: Glatko, profesionalno, radi u svim kontekstima
• Gurnite: Očistite promenu pravca
• Obrisati: Jednostavno i jasno
• Izbegavajte: Upadljivi efekti koji odvlače pažnju od tehničkog sadržaja

Vežba:
• Nanesite "Fade" prelaz na sve slajdove
• Podesite trajanje na 1 sekundu
• Promenite jedan slajd da biste koristili "Push" tranziciju sa efektom "Sa desne 

strane"
• Testirajte prelaze koristeći prikaz slajdova
• Uporedite priručnik vs. automatsko slajd unapred



Slide Master Osnove

Naslov: Razumevanje master slajdova za konzistentnost
Sadržaj:
• Šta je Slide Master?

• Šablon koji kontroliše ukupni dizajn prezentacije
• Definiše formatiranje, fontove, boje i držače mesta
• Izmene napravljene u master primenjuju se na sve slajdove automatski
• Obezbeđuje doslednost i štedi vreme

• Pristup Slide Master-u:
• Pogledaj karticu → Slide Master
• Prikazuje hijerarhijsku strukturu: Master slajd i rasporede
• Gornji slajd: Master (utiče na sve)
• Ispod: Pojedinačni rasporedi (naslov, sadržaj, itd.)



Slide Master Osnove

• Slide Master komponente:
• Tematske boje i fontovi
• Pozadinski stilovi i slike
• Elementi podnožja (datum, broj slajda, tekst)
• Postavljanje logotipa
• Podrazumevano formatiranje teksta

• Uređivanje Slide Master:
• Izaberite master ili raspored za uređivanje
• Napravite izmene: fontove, boje, držače mesta
• Ubacite elemente: logotipi, vodeni žigovi, pozadine
• Promene se automatski primenjuju na relevantne slajdove



Slide Master Osnove

• Zajedničke master izmene:
• Dodajte logo kompanije / institucije na sve slajdove
• Promenite podrazumevane fontove i veličine
• Izmena sadržaja podnožja
• Podesite pozicije držača mesta
• Podesite konzistentne stilove metaka

• Glavni držači mesta:
• Naslov zamena
• Držač mesta za sadržaj
• Držači mesta u podnožju (datum, tekst podnožja, broj slajda)
• Prilagođeni držači mesta (za dosledno pozicioniranje)

• Zatvaranje slajda Master Viev:
• Slide Master kartica → Zatvori Master Viev
• Povratak u normalan režim uređivanja
• Promene su sada vidljive u prezentaciji



Slide Master Osnove

• Prednosti za studente inženjerstva:
• Kreirajte šablon jednom, koristite za više projekata
• Održavajte profesionalnu doslednost
• Uštedite vreme na formatiranju
• Lako se ažurira brendiranje preko prezentacije

Vežba:
• Otvori prikaz master slajdova
• Dodajte logo svoje institucije na glavni slajd
• Promenite podrazumevani font naslova u Arial KSNUMKSpt bold
• Dodajte brojeve slajdova u podnožje
• Zatvori glavni prikaz i posmatraj promene na svim slajdovima



Režimi predstavljanja i gledanja

Naslov: Efikasno izvođenje prezentacije
Sadržaj:
• Početak prezentacije:

 Metod KSNUMKS: Slide Shov kartica → Od početka (FKSNUMKS)
 Metod KSNUMKS: Kartica slajdova → Od trenutnog slajda (Shift + FKSNUMKS)
 Metod KSNUMKS: Ikona slajdova u donjem desnom uglu

• Prezentacija Navigacija:
 Sledeći slajd: Kliknite mišem, pritisnite prostor ili strelicu desno
 Prethodni slajd: Pritisnite Backspace ili strelicu levo
 Idi na određeni slajd: Upišite broj slajda + Enter
 Kraj emisije: Pritisnite taster Esc



Režimi predstavljanja i gledanja
• Pogled predavača:

• Dostupno kada se koristi više ekrana
• Prikazuje: Trenutni slajd, sledeći slajd, beleške, tajmer
• Pristup: Slide shov → Koristite prikazivač
• Prednosti:

 Pogledajte svoje beleške dok publika vidi samo slajdove
 Pregledajte predstojeće slajdove
 Proteklo vreme na stazi
 Lako se krećite slajdovima

• Alati za crtanje i napomene:
• Kliknite desnim tasterom miša tokom prezentacije → Opcije pokazivača
• Olovka: Crtajte slajdove tokom prezentacije
• Highlighter: Naglasite tekst
• Laserski pokazivač: Tačka bez crtanja (Ctrl + L)
• Eraser: Uklonite napomene
• Boje: Izaberite boju mastila
• Koristi se za: Naglašavanje formula, kruženje podataka, dodavanje beleški



Režimi predstavljanja i gledanja

Opcije ekrana tokom prezentacije:
• Crno-beli ekran: B (crni) ili V (beli) taster
• Privremeno pauzirajte prezentaciju
• Nastavi: Pritisnite bilo koji taster

• Funkcija zumiranja:
• Uvećajte deo slajda za detalje
• Kliknite slajd i uvećajte određenu oblast
• Korisno za detaljne dijagrame ili mali tekst

• Proba:
• Slide shov → Vreme probe
• Praksa prezentacije i snimanje vremena
• Pregledajte vreme provedeno na svakom slajdu
• Podesite sadržaj ako slajdovi traju predugo



Režimi predstavljanja i gledanja

Vežba:
• Započnite prezentaciju od početka
• Vežbajte navigaciju napred i nazad
• Koristite alat za olovku da biste zaokružili važnu vrednost
• Aktivirajte laserski pokazivač i vežbajte pokazivanje
• Prebaci crni ekran tokom prezentacije
• Vreme probe i pregled rezultata



Štampanje i izvoz prezentacija

Naslov: Deljenje vašeg rada u različitim formatima
Sadržaj:
• Štampanje prezentacija:

• File → Print (ili Ctrl + P)
• Opcije štampanja:

 Slajdovi preko cele stranice: Jedan slajd po stranici (veliki)
 Materijali: Više slajdova po stranici (KSNUMKS, KSNUMKS, KSNUMKS, 

KSNUMKS, KSNUMKS)
 Napomene Stranice: Slajdovi sa beleškama govornika ispod
 Pregled: Prikaz samo za tekst

• Postavke:
 Odštampaj sve slajdove / trenutni slajd / prilagođeni opseg
 Boja / Sivi tonovi / Čista crno-bela
 Prikupljeni / Neprikupljeni
 Portretna / pejzažna orijentacija



Štampanje i izvoz prezentacija

• Preporučena podešavanja štampe za studente:
• Brošure (3 slajda po stranici): Prostor za beleške sa desne strane
• Brošure (KSNUMKS slajdovi po stranici): Kompaktan pregled
• Sivi tonovi: Štedi mastilo u boji, ostaje čitljiv

• Izvoz u PDF:
• Datoteka → izvoz → kreiranje PDF / KSPS dokumenta
• Prednosti:

 Univerzalni format (otvara se bez PoverPoint-a)
 Tačno čuva formatiranje
 Manja veličina datoteke
 Ne može se lako menjati (bezbednost)

• Opcije:
 Standardni kvalitet (preporučeno)
 Minimalna veličina (za e-poštu)



Štampanje i izvoz prezentacija

• Izvoz u video:
• File → Izvoz → Kreiranje video
• Izaberite kvalitet: Full HD (1920×1080) ili niže
• Podesite vreme: Koristite snimljene vremenske okvire ili fiksne sekunde
• Korisno za: Online deljenje, automatsku reprodukciju

• Izvoz u slike:
• File → Izvoz → Promena tipa datoteke → PNG ili JPEG
• Izvozi svaki slajd kao pojedinačnu datoteku slike
• Korisno za: Veb stranice, društveni mediji, dokumentacija

• Prezentacija paketa za CD:
• File → Izvoz → Prezentacija paketa za CD
• Uključuje fontove i povezane datoteke
• Obezbeđuje prezentacija radi na drugim računarima



Štampanje i izvoz prezentacija

• Čuvanje u različitim PoverPoint formatima:
• .pptx: Standardni format (2007 i kasnije)
• .ppt: Kompatibilan sa starijim verzijama (pre 2007)
• .ppsk: PoverPoint Shov (otvara se direktno kao prezentacija)
• .potk: Format šablona (dizajn za višekratnu upotrebu)

Vežba:
• Štampajte brošure sa 3 slajda po stranici
• Izvoz prezentacije kao PDF
• Sačuvaj jedan slajd kao PNG sliku
• Uporedite veličine datoteka različitih formata
• Kreirajte PoverPoint Shov (.ppsk) verziju



Najbolje prakse i rezime

Naslov: Kreiranje efikasnih inženjerskih prezentacija
Sadržaj:
Najbolje prakse dizajna:

Jednostavnost: Jedna glavna ideja po slajdu
Konzistentnost: Koristite iste fontove, boje, raspored
Kontrast: Obezbedite tekst čitljiv u pozadini
Razmak: Ne prenatrpavajte slajdove
Vizuelna hijerarhija: Učinite važne elemente istaknutim

Smernice za sadržaj:
Koristite tačke, a ne paragrafe
6×6 pravilo: Maksimalno 6 metaka, 6 reči po metku
Podrška tekst sa vizuelnim prikazima (dijagrami, grafikoni, slike)
Izbegavajte čitanje slajdova doslovno
Koristite tehničku terminologiju na odgovarajući način



Najbolje prakse i rezime

Saveti specifični za inženjering:
Uključite jasne dijagrame i šeme
Označite sve grafikone i grafikone sa jedinicama
Koristite jednačine i formule kada je to potrebno
Predstavite podatke u tabelama ili vizualizacijama
Uključite reference za tehničke informacije
Dodajte brojeve slajdova radi lakšeg snalaženja

Uobičajene greške koje treba izbegavati:
Previše teksta na slajdovima
Boje niskog kontrasta (žuta na belo, itd.)
Preterane animacije i prelazi
Čitanje direktno sa slajdova
Nedosledno formatiranje
Slike lošeg kvaliteta (pikselizirane)
Nedostaju oznake na tehničkim dijagramima



Najbolje prakse i rezime
Saveti za isporuku prezentacije:

Vežbajte više puta
Upoznajte svoj sadržaj temeljno
Održavajte kontakt očima sa publikom
Koristite prikaz prezentera sa beleškama
Predvidite pitanja o tehničkim detaljima
Imajte rezervni plan (PDF verzija, štampani materijali)

Rezime ključnih veština:
✓ Pouzdano se krećete po PoverPoint interfejsu
✓ Kreirajte i sačuvajte prezentacije
✓ Dodajte, brišite i organizujte slajdove
✓ Formatirajte tekst profesionalno
✓ Primenite teme i rasporede za konzistentnost
✓ Efikasno ubacite i formatirajte slike
✓ Ubacite i formatirajte slike efikasno
✓ Koristite animacije i prelaze na odgovarajući način



Najbolje prakse i rezime
Rezime ključnih veština:
✓ Koristite Slide Master za doslednost
✓ Predstavite efikasno koristeći različite načine
✓ Štampajte i izvozite u više formata
Vežba - Završni projekat:
Napravite kompletnu tehničku prezentaciju KSNUMKS-slajdova na temu elektrotehnike:
1. Primenite profesionalnu temu
2. Uključite naslovni slajd sa svojim imenom
3. Koristite različite rasporede na odgovarajući način
4. Ubacite i formatirajte najmanje KSNUMKS slike / dijagrame
5. Primenite konzistentne, suptilne prelaze
6. Dodajte animacije ključnim tačkama
7. Uključite brojeve slajdova u podnožje
8. Vežbajte predstavljanje u Presenter Viev-u
9. Izvozi kao PDF
10. Štampanje brošura (3 slajda po stranici)



Dodatni resursi za studente

Online tutorijali:
Microsoft PoverPoint zvanična obuka
IouTube: PoverPoint inženjerska prezentacija tutorijala
LinkedIn učenje: PoverPoint kursevi
Praktične aktivnosti:
Kreirajte šablone prezentacija za buduće projekte
Dizajn prezentacije za laboratorijske izveštaje
Pripremite prezentacije za predloge projekata
Kreirajte nastavne prezentacije za vršnjake
Saveti za kontinuirano poboljšanje:
Prezentacije studija sa konferencija i seminara
Zatražite povratne informacije od instruktora i vršnjaka
Eksperimentišite sa različitim pristupima dizajnu
Izgradite biblioteku šablona slajdova za višekratnu upotrebu
Budite u toku sa PoverPoint novim funkcijama
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